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Foreword

This manual contains information about the image/firmware/system program (from now on referred
to as image) and how to get started with the device in the most common applications.

The information in this manual is valid for the latest versions of hardware at the time the manual was
released. All documentation is available in our Download center.

Visit Beijer Electronics SmartStore for image updates and software downloads.

Copyright © 2024 Beijer Electronics AB. All rights reserved.

The information in this document is subject to change without notice and is provided as availa-
ble at the time of publishing. Beijer Electronics AB reserves the right to change any information
without updating this publication. Beijer Electronics AB assumes no responsibility for any errors
that may appear in this document. All examples in this document are only intended to improve
understanding of the functionality and handling of the equipment. Beijer Electronics AB cannot
assume any liability if these examples are used in real applications. In view of the wide range
of applications for this software, users must acquire sufficient knowledge themselves in order
to ensure that it is correctly used in their specific application. Persons responsible for the
application and the equipment must themselves ensure that each application is in compliance
with all relevant requirements, standards, and legislation in respect to configuration and safety.
Beijer Electronics AB will accept no liability for any damage incurred during the installation or
use of equipment mentioned in this document. Beijer Electronics AB prohibits all modification,
changes, or conversion of the equipment.

https://www.beijerelectronics.com/en/Support/file-archive-tree-page
https://smartstore.beijerelectronics.com/en/Software/Software___products
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1. Introduction

BoX2 is a series of protocol converters, IIoT gateways and edge controllers that combine clever
connectivity with smart functions such as local data base storage, alarm servers, data exchange,
reporting, C# scripting, etc. BoX2 series is configured (except BoX2 pro motion) with iX Developer.
For BoX2 pro SC/BoX2 extreme SC, BCS Tools 3.50 or later is used to write the PLC program.

Please refer to the BoX2 Hardware and Installation manuals (with technical data as well as cutout
and outline dimensions) and iX Developer manuals for further information. All documentation is
available in our Download center.

1.1. Note, Tip and Important Icons
This publication may include Important and Note icons where appropriate to point out safety-related,
or other important, information. It may also include Tips to point out useful hints to the reader. The
corresponding symbols should be interpreted as follows:

NOTE
The Note icon alerts the reader to pertinent facts and conditions.

TIP
The Tip icon indicates advice on, for example, how to design your project or how to
use a certain function.

IMPORTANT
The Important icon highlights important information.

1.2. Trademarks
Microsoft, Windows, Windows Embedded CE 6.0 R3, Windows Embedded Compact 2013, Windows 7,
Windows Embedded Standard 7 are registered trademarks or trademarks of Microsoft Corporation
in the USA and/or other countries. Any additional trade names given in this documentation are
trademarks of their corresponding owners.

Introduction
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1.3. References

Name Description

MAEN361 Best Practice Image Update

MAEN362 Hardware and Installation Manual BoX2 base v2

MAEN275 Hardware and Installation Manual BoX2 pro

MAEN276 Hardware and Installation Manual BoX2 extreme

MAEN355 Reference Manual iX Developer

Version: 2.40 SP7 b 2.47.473 and later

MAEN831 Reference Manual iX Developer

Version: 2.40 SP7 b 2.47.417 and earlier

MAEN832 User's Guide iX Developer

MU299609 BCS Tools - User Manual

KI00390 BoX2 pro motion and BSD Start up manual

The installation, technical data as well as cutout and outline dimensions of the devices are
described in the Hardware and Installation manual for each device. Please refer to the Hardware
and Installation manuals and the iX Developer manuals for further information.

NOTE
For image and software updates/downloads, visit Beijer Electronics SmartStore.

Additional information, such as Start Up guides, manuals and “Best practice"
documents are available in our Download center.

NOTE
For specifications on supported USB memories and SD cards, please refer to the
Hardware and Installation manual for your specific BoX2 device.

1.4. Operating Systems

Image family Operating system license Runtime licenses

BoX2 base v2

Windows Embedded Compact 2013
(General Embedded)

iX Runtime

BoX2 pro iX Runtime

BoX2 pro SC iX Runtime and CODESYS
Runtime

BoX2 pro motion CODESYS motion runtime

iX Runtime excluded.

BoX2 extreme iX Runtime

BoX2 extreme SC iX Runtime and CODESYS
Runtime

Introduction
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2. General Information

NOTE
BoX2 pro motion is only partly covered in this manual. For more information on
configuring the BoX2 pro motion, see the BoX2 pro motion and BSD Start up manual
(KI00390).

IMPORTANT
When updating the system image through “Make recovery SD card” an SD card
formatted with FAT16/FAT32 and maximum 32 GB must be used.

2.1. Default IP Addresses
These are the default IP addresses for the BoX2 devices:

BoX2 base v2, extreme (incl. SC), pro (incl. SC) BoX2 pro motion

LAN A 192.168.1.1 None (EtherCAT)

LAN B DHCP 192.168.1.1

NOTE
Devices with 2 Ethernet ports MUST NOT have IP addresses in the same subnet.

2.2. Open Ports
In the firmware there are some ports that are open by default due to the operating system or that
the internal application requires it.

Type Description Open by default

UDP and TCP Project transfer (9999) Yes

UDP Netbios (137) Yes

UDP Netbios (138) No1

1Filtered.

2.3. LED Indication
BoX2 uses three colors for LED indication; Red, Purple and Blue.

2.3.1. Red

State Description

Constant on Unit is busy booting, or updating image through recovery SD card.

Every 2 seconds
on/off

Unit is in standby/update mode. If image recovery has been run, then
this indicates it has finished, eject SD card and reboot unit.

General Information
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State Description

Fast flashing Eject USB/SD card.

NOTE
Fast flashing continues for a couple of seconds after
ejecting the USB/SD card.

2.3.2. Purple

State Description

Constant on Operating system is booting up.

Every 0.5 seconds
on/off

The unit is on standby and no iX Runtime or CODESYS project is
running.

Fast flashing for 5
seconds

USB/SD card project (iX or CODESYS) update successful.

2.3.3. Blue

State Description

Every 0.5 seconds
on/off

The iX project is running.

Every 0.5 seconds,
short flash

CODESYS project is running.

Every 0.5 seconds,
alternately short
and long flash

Both iX and CODESYS running.

NOTE
If the LED alternatively flashes Red to Blue to Purple, the wrong image type is
installed. Please reinstall correct image.

General Information
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3. Configuration

To be able to configure the BoX2 device, the following software might be required:

• iX Developer

NOTE
Not applicable for BoX2 pro motion.

• BCS Tools for BoX2 with CODESYS Runtime.

3.1. How to Set the IP Address in BoX2
Changing the IP address on a BoX2 device can be done through our BoX2 Configuration Tool or by
editing a JSON-file manually. For instructions on manually editing the JSON-file, see the following
chapter.

3.1.1. Manually Editing the JSON-file

NOTE
On BoX2 pro SC, BoX2 pro motion and BoX2 extreme SC, if the EtherCAT driver is
enabled, LAN A is used for EtherCAT only.

LAN B is for programming and communication.

Follow these steps to edit the network settings on a BoX2 base v2, BoX2 pro (incl. motion) and BoX2
extreme:

1. Download and extract this zip-file on your computer.
The zip-file and instructions can also be found here.

2. Edit the JSON-file to change the network settings.
In the following example, IP-address on LAN B is changed:
Original content in JSON-file:

{      
    "Number": "6",      
    "Enabled": true,      
    "Command": "LAN B IP",      
    "Entry": [        
    "192.168.1.1"      
    ],      
    "Comment": ""
},

Configuration
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Edited content in JSON-file:

{      
    "Number": "6",      
    "Enabled": true,      
    "Command": "LAN B IP",      
    "Entry": [        
    "192.168.1.2"      
    ],      
    "Comment": ""    
},

NOTE
"Enabled" must be set to 'true' for the change to take effect.

Several settings can be changed at the same time, but they must all be set to
'true'.

NOTE
Do not change the file name.

3. Put "BoX2ConfigSet.json" on a USB flash drive or SD card and connect it to your BoX2 device.
This will immediately update the network settings. When the change is done the LED on the BoX2
will change temporarily to a red flash.

4. A log file will be created on the USB flash drive, this can be used to verify that the setting was
changed. Example:

"New result file input
Time: 2000-5-28 21:32:37
LAN B set IP: 192.168.1.2
Adapter rebind LAN B successful"

The network settings have been updated.

Configuration
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4. Image and CODESYS Runtime Update

The device comes pre-loaded with a system image (including firmware and system program).

Images and the Image Loader utility, can be downloaded from the Firmware section in our
SmartStore.

CODESYS runtime is available from the Firmware section in our SmartStore.

IMPORTANT
CODESYS runtime update is only applicable for devices with a CODESYS runtime
license, such as BoX2 pro SC and extreme SC.

The image/Image Loader utility is used for:

• Updating the image by,

• creating an Image Loader SD card or USB flash drive

• transferring an image to a device through Ethernet

• Updating the CODESYS Runtime by,

• creating an auto-install package for SD card or USB flash drive

• transferring the CODESYS Runtime over Ethernet

In some occasions it is necessary to make a complete system update via Make Recovery SD card.

IMPORTANT
On a BoX2 pro device with image version 2.0 b775 or older, we recommend to update
the image using Make Recovery SD Card. This means that the iX Developer project
and IP settings must be backed up from the device before the image is updated. See
manual MAEN361 chapter 1.2 on how to do the backup.

Image and CODESYS Runtime Update
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IMPORTANT
On a BoX2 extreme device with image version older than 2.0 b365, we recommend to
update the image using Make Recovery SD Card. This means that the iX Developer
project and IP settings must be backed up from the device before the image is
updated. See manual MAEN361 chapter 1.2 on how to do the backup.

To summarize, the image/CODESYS runtime can be updated in the following ways:

Update method iX Developer project deleted by
updating

IP address reset by updating

USB No No

SD No No

Ethernet No No

Recovery SD card1 Yes Yes
1Only available for image update.

4.1. Update the Image Using USB or SD Card
Do the following:

1. Download your image from Beijer Electronics SmartStore.

2. Unzip the downloaded file and start the Image Loader application.

3. Connect a USB flash drive or SD card to the computer.

4. In Select drive:, choose the connected USB flash drive or SD card.

5. Click Create.

6. When finished, eject the USB flash drive or SD card.

7. Connect the USB flash drive or SD card to the BoX2 device and power up the device. 

8. Wait until red LED indication starts flashing fast and eject the USB flash drive or SD card.

Image and CODESYS Runtime Update
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NOTE
Make sure to eject the USB/SD card. Otherwise, the device will try to update
again during next boot up.

9. The device automatically reboots.

10. Wait until the LED shows a blue status light, or purple on/off every 0.5 seconds (if no iX or
CODESYS project is installed).

The update is now completed.

4.2. Update the Image Over Ethernet
The Image Loader utility can be used to update the image over Ethernet.

IMPORTANT
Before doing any transfer over Ethernet, ensure that the network is considered
secure in order to limit the risk of any malicious intrusion.

Some best practices that are encouraged:

• Use strong passwords to ensure that network devices (routers/switches/servers)
are protected with strong, passwords.

• Utilize encryption protocols to encrypt data packets.

• Divide the network into separate segments to limit the impact of a security
breach.

• Configure Access Control Lists on network devices to restrict traffic based on IP
addresses/protocols/ports.

• Restrict access to your network by only allowing trusted devices based on MAC
addresses.

• Regularly update firmware and software on the network devices.

• If running remote, make sure to connect via VPN to create a secure tunnel for data
transmission.

• Ensure that all firmware is validated and verified before transfer, ensuring that
there is no risk of tampering.

NOTE
Before trying to update the image over Ethernet, make sure that your PC is on the
same IP-subnet as the BoX2 device. If your device has an IP address of 192.168.1.1,
and a subnet mask of 255.255.255.0, then your PC must have an IP address in the
range of 192.168.1.2 – 192.168.1.254 and a subnet mask of 255.255.255.0, in order
to communicate with the device.

Do the following:

1. Enter the device Target IP address in the dialog and click on Update to start the update.

Image and CODESYS Runtime Update
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2. The dialog shows the current installed image and the new image that the device will be updated
to. Click on Update Now! to confirm the start of the update.

3. A progress bar shows the update transfer status. When the transfer is done, the device will
reboot.

4. Wait until the LED shows a blue status light, or purple on/off every 0.5 seconds (if no iX or
CODESYS project is installed).

The update is now completed.

NOTE
If the device contains a CODESYS Runtime, then the CODESYS Runtime must be
transferred to the device after the image has been updated. See section Update
the CODESYS Runtime Version Using USB or SD Card or Update the CODESYS Runtime
Version Over Ethernet.

4.3. Update the Image Version Using Recovery SD Card
In a complete system update the IP settings will be reset to default values and the iX Developer
project will be deleted. To keep the IP setting and the iX Developer project it is recommended to
make a backup of the iX Developer project and make a note of the IP settings prior to an image
update.

NOTE
When updating the system image through “Make recovery SD card” an SD card
formatted with FAT16/FAT32 and maximum 32 GB must be used.

Image and CODESYS Runtime Update
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Do the following:

1. In Select drive:, choose the connected SD card.

2. Create an image recovery SD card by selecting Make Recovery SD card when using the Image
Loader utility.

3. Click Create.

4. When finished, eject the SD card.

5. Connect the SD card to the BoX2 device and boot the device. 

6. A red LED indication, with constant light, will indicate that the device is booting and updating
the image.

7. When the red LED indication starts to slowly blink, 2 seconds on, 2 seconds off, the update is
complete.

8. Eject the SD card and reboot the device.

9. After the reboot, wait until the LED indications shows purple, on/off every 0.5 seconds.

The update is now completed.

4.4. Update the CODESYS Runtime Version Using USB or SD Card

NOTE
Refer to document SUEN00392, available at Help Online, for more details and
recommendations on using the X2/BoX2 series range of products with embedded
CODESYS runtime.

To update the CODESYS Runtime, the folder containing the CODESYS .cab-files listed below must be
specified in the Image Loader utility. The existing Power Management and EtherCAT Distributed Clock
settings are shown in the Image Loader utility and can be set before updating the CODESYS Runtime.

Image and CODESYS Runtime Update
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Do the following:

1. Select the folder that contains the CODESYS files.

2. Select the desired options for Retain data, EtherCAT and OPC UA and click Create auto-install
package.

NOTE
The only valid options for BoX2 motion are Power fail retain and EtherCAT with
distributed clock.

Image and CODESYS Runtime Update
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NOTE
The PLC functionality has support for storing non-volatile variables. Those
variables can be stored dynamically in two different modes:

• Power-fail mode (Default setting)
If the voltage drops below a hardware given threshold (that is, during a power
loss or power dip), the system instantly copies all persistent data defined in
the PLC application from RAM into the battery backed SRAM. They are verified
and restored when the device is restarted.

• Cyclic mode
The PLC is instructed to store all retain and persistent data directly into SRAM
synchronously with every PLC cycle. This means all device types can use the
whole available memory, which is 128 kB. However, writing to the SRAM might
increase the configured PLC cycle depending on the size of used retain and
persistent data, because a SRAM is naturally slower than a RAM. This possible
increase is dependent of the application and to find out about the possible
increase one would need to monitor the configured task(s) of the project. For
projects with large amounts of persistent data, cyclic mode is recommended.

3. Save the auto-install package to your connected USB or SD card.

4. Eject the USB or SD card.

5. Connect the USB flash drive or SD card to the device and boot the device.

6. Wait until red LED indication starts flashing fast and eject the USB flash drive or SD card.

NOTE
Make sure to eject the USB/SD card. Otherwise, the device will try to update
again during next boot up.

7. The device automatically reboots.

8. Wait until the LED shows a blue status light, or purple on/off every 0.5 seconds (if no iX or
CODESYS project is installed).

The update is now completed.

Image and CODESYS Runtime Update
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4.5. Update the CODESYS Runtime Version Over Ethernet

IMPORTANT
Before doing any transfer over Ethernet, ensure that the network is considered
secure in order to limit the risk of any malicious intrusion.

Some best practices that are encouraged:

• Use strong passwords to ensure that network devices (routers/switches/servers)
are protected with strong, passwords.

• Utilize encryption protocols to encrypt data packets.

• Divide the network into separate segments to limit the impact of a security
breach.

• Configure Access Control Lists on network devices to restrict traffic based on IP
addresses/protocols/ports.

• Restrict access to your network by only allowing trusted devices based on MAC
addresses.

• Regularly update firmware and software on the network devices.

• If running remote, make sure to connect via VPN to create a secure tunnel for data
transmission.

• Ensure that all firmware is validated and verified before transfer, ensuring that
there is no risk of tampering.

NOTE
Refer to document SUEN00392, available at Help Online, for more details and
recommendations on using the X2/BoX2 series range of products with embedded
CODESYS runtime.

To update the CODESYS Runtime, the folder containing the CODESYS .cab-files listed below must be
specified in the Image Loader utility. The existing Power Management and EtherCAT Distributed Clock
settings are shown in the Image Loader utility and can be set before updating the CODESYS Runtime.

Image and CODESYS Runtime Update
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Do the following:

1. Select the folder that contains the CODESYS files.

2. Input the Target IP address for the device.

3. Press the Get info button to make sure that communication with the device is working.

4. Select the desired options for Retain data, EtherCAT and OPC UA.

NOTE
The only valid options for BoX2 motion are Power fail retain and EtherCAT with
distributed clock.

Image and CODESYS Runtime Update
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NOTE
The PLC functionality has support for storing non-volatile variables. Those
variables can be stored dynamically in two different modes:

• Power-fail mode (Default setting)
If the voltage drops below a hardware given threshold (that is, during a power
loss or power dip), the system instantly copies all persistent data defined in
the PLC application from RAM into the battery backed SRAM. They are verified
and restored when the device is restarted.

• Cyclic mode
The PLC is instructed to store all retain and persistent data directly into SRAM
synchronously with every PLC cycle. This means all device types can use the
whole available memory, which is 128 kB. However, writing to the SRAM might
increase the configured PLC cycle depending on the size of used retain and
persistent data, because a SRAM is naturally slower than a RAM. This possible
increase is dependent of the application and to find out about the possible
increase one would need to monitor the configured task(s) of the project. For
projects with large amounts of persistent data, cyclic mode is recommended.

5. Press Update to perform the update.

NOTE
This button is disabled until communication has been established with the
device, by previously pressing the Get info button.

6. The BoX2 device will show a purple LED indication, with constant light, to indicate that the
CODESYS Runtime is updating.

7. Once finished, the device will automatically reboot.

8. Wait until the LED shows a blue status light, or purple on/off every 0.5 seconds (if no iX or
CODESYS project is installed).

The update is now completed.

NOTE
Before downloading a new CODESYS Runtime, the image should always first be
downloaded to the device again, even if there are no changes to the image. If only
the CODESYS Runtime is installed, then this may result in problems connecting to,
and communicating with, other devices.

Image and CODESYS Runtime Update
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5. Getting Started and Commonly Used Functions

IMPORTANT
Before doing any transfer over Ethernet, ensure that the network is considered
secure in order to limit the risk of any malicious intrusion.

Some best practices that are encouraged:

• Use strong passwords to ensure that network devices (routers/switches/servers)
are protected with strong, passwords.

• Utilize encryption protocols to encrypt data packets.

• Divide the network into separate segments to limit the impact of a security
breach.

• Configure Access Control Lists on network devices to restrict traffic based on IP
addresses/protocols/ports.

• Restrict access to your network by only allowing trusted devices based on MAC
addresses.

• Regularly update firmware and software on the network devices.

• If running remote, make sure to connect via VPN to create a secure tunnel for data
transmission.

• Ensure that all firmware is validated and verified before transfer, ensuring that
there is no risk of tampering.

5.1. Create and Download Project Using iX Developer

5.1.1. Create a Project in iX Developer
For information on creating a new project in iX Developer, see the iX Developer Reference Manual.

When creating a new project for BoX2 devices, we recommend setting the target to BoX2 base/pro
(SC)/extreme (SC) with VNC.

Getting Started and Commonly Used Functions
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Creating a BoX2 target with VNC allows the user to create graphical screens that can be viewed
remotely via VNC. This can is some cases lead to easier configuration and troubleshooting of the
device.

Creating a target without VNC means that the possibility to create screens and to access them
through VNC is disabled, the hardware and image are identical. A project created without VNC can
afterwards be changed to VNC enabled by changing Target Type in “Project - Settings - Display/
Target”.

NOTE
It is possible to switch from a target without VNC to a target with VNC at any time,
but not the other way around.

For more information on how to enable VNC in iX Developer, see Remote Access (FTP and VNC) in iX
Developer 2.xx, SUEN00314.

5.1.2. Download the iX Developer Project
To download an iX Developer project to a device, you can choose to either export the project to a
USB/SD card or to download the project over Ethernet.

NOTE
Not applicable for BoX2 pro motion.

Export Project to USB or SD Card
1. Open your project in iX Developer.

2. Select the Project tab and click Export.

Getting Started and Commonly Used Functions
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3. In the pop-up window, find and select the root folder of your USB/SD card, and save the project
there by clicking Save.

NOTE
Make sure Save as type is set to Export to folder.

4. Eject the USB/SD card.

5. Connect the USB/SD card to your BoX2 device and boot it.

6. Wait until you get a blue LED-indication.

The installation is now completed.

Download Over Ethernet
1. Connect the BoX2 device to the PC via an Ethernet connection.

2. Open your project in iX Developer.

3. Select the Project tab and click Download.

4. The Download Project dialog opens, and all devices connected in the network are listed with
information about IP address and device type.
Select your BoX2 device from the list.

5. Check that the IP address is correct and click Download.

a. Optional: Click the Include compressed project check box, to compress the project and
save it as a ZIP file.

b. Optional: Click the Password protected check box and enter a password, to protect the ZIP
file.

c. Optional: Click the Copy downloaded project to Memory card check box, to enable SD
card backup of project and settings.

6. The BoX2 device responds to a download request by stopping any current project. The LED will
show purple on/off every 0.5 seconds.

7. Wait until you get a blue LED-indication.

The installation is now completed.

Getting Started and Commonly Used Functions
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5.2. Data Exchange Between Two Controllers

5.2.1. Configure Controllers

NOTE
In iX Developer, COM port settings can be adjusted on the System ribbon tab.

In iX Developer, do the following:

1. Click the Tags icon, (1) in the Project Explorer.
2. Click on the Controllers tab (2).

NOTE
In this example we will add two controllers and exchange data between them
through your BoX2 device.

3. Click on the Controller... button (3).

4. Identify your controller and select it in the Select brand and Select protocol lists. Click OK.

Getting Started and Commonly Used Functions
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5. Click the Settings... button to configure your controller.

NOTE
If you are unsure about Settings and Addressing, see our Drivers documentation,
accessed by clicking Help in the bottom right corner of the Settings... dialog.

6. Rename your controller by changing the name in the controllers list.

7. Click on Add and repeat steps 4 - 6 for your second controller.

5.2.2. Configure Data Exchange
To be able to configure data exchange, at least two controllers must be configured in the project
(see how this is done in the previous chapter).

In iX Developer, do the following:

1. Click on the Tags tab.

2. Check the Data Exchange checkbox under Columns Visible.

Getting Started and Commonly Used Functions
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NOTE
Un-checking the checkbox will not remove your settings, it is just a visibility
filter.

3. Use the default Tag1 or add new ones. Select Data Type and add addresses for your controllers.

4. Under Data exchange > Direction, click the ... button and select how the data should be
exchanged.

In the following screenshot, data exchange is configured to move the data for the selected
tag from the device configured under the Demo_Controller_2 to the device configured under
Demo_Controller_1.

In this case, it would mean that the value from C1 in Demo_Controller_2 would be copied to D1
in Demo_Controller_1:

NOTE
The direction setting must be configured separately for each tag.
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5. When the data exchange is configured, click the Download button under the Project tab in the
Ribbon at the top of the screen.

6. Select (1) your BoX2 device as the target and click Download (2).

A green checkmark will illustrate that the project has been downloaded.

NOTE
Before further configuring data exchange, make sure that communication to all
devices works.

This is done by:

1. Opening the downloaded iX Runtime project on your BoX2 device remotely from
your PC.
For information on enabling VNC in iX Developer, see previous section Create a
Project in iX Developer and separate document Remote Access (FTP and VNC) in
iX Developer 2.xx, SUEN00314.

2. In the iX Runtime project, check that the tags that are configured to the
different controllers receive values as expected.

5.3. Enable Diagnostics Page
The diagnostics page shows diagnostic values from the BoX2 device. The diagnostic values include
internal temperature, available RAM, used storage, connection and database errors and other system
related information. The diagnostic page can be viewed after the project is downloaded to the
device.

In iX Developer:

1. Open Web server configuration from System ribbon tab. Set values needed to access web server
and enable web server for the project.
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NOTE
The URL for the diagnostics page should include the assigned port number.

2. Add system tags, used on the page, manually to the project. If the system tag is missing, ‘-’ will
be displayed on the page.

NOTE
The following system tags are available:

• Communication Errors (count)
(SystemTagCommunicationErrorMessage)

• Communication Error Message
(SystemTagCommunicationErrorMessage)

• Database Error Active
(SystemTagStorageErrorActive)

• Database Error Message
(SystemTagStorageErrorMessage)

• Database Max Size Exceeded
(SystemTagStorageMaxSizeExceeded)

• Current Date and Time
(SystemTagDateTime)

• Debug Logging Enabled
(SystemTagDebugLoggingEnabled)

3. Select Functions - Tags - Add - Add System Tag…. Select and add needed tags in System tags
dialog.
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4. Deploy by either upload files via FTP or copy into the ProjectFiles folder. Diagnostics
page files are installed with iX Developer installation and reside in iX Developer
<version>\Bin\DiagnosticsPage.

a. Enable FTP server for the project.

i. On the System ribbon tab (1), within the Servers group, click FTP (2).

ii. In the dialog, check the Enable FTP server checkbox (3).

iii. (Optional) Set a username and password.

iv. Click OK.

b. Download the project to the BoX2 device through Project - Download.
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c. Connect to the BoX2 device. Use FTP settings specified in the project with the help of any
FTP client.

d. Create a new folder named ‘diagnostics’ in the ‘Website’ folder and copy the diagnostics
page files into it.

Use this URL to access the diagnostic page: http://<image_ip_address><:port>diagnostics/index.html
to access the page. Use the port defined in the web server configuration. If Forms authentication is
enabled for the web server, user is first taken through authentication process. The page is updated
asynchronously every 2 seconds with the latest data.

NOTE
For more information about how to use FTP, see Remote Access (FTP and VNC) in iX
Developer 2.xx, SUEN00314.

5.4. Create a Project in BCS Tools and Download the PLC
Program

5.4.1. Create a Project in BCS Tools
If you are using a CODESYS Runtime in BoX2 pro SC or BoX2 extreme SC, the software BCS Tools is
required

BCS Tools can be downloaded from Beijer Electronics SmartStore.

Once you have downloaded and launched BCS Tools, do the following to create your project:

1. Click File > New project....

2. Choose Standard Project.
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3. In the BCS Tools Standard Project window, click the Choose the device category: drop-down
and select the Edge Controllers group.

4. Click the Choose the device model: drop-down and select your BoX2 device from the list.

NOTE
The PLC functionality has support for storing non-volatile variables. Those
variables can be stored dynamically in two different modes:

• Power-fail mode (Default setting)
If the voltage drops below a hardware given threshold (that is, during a power
loss or power dip), the system instantly copies all persistent data defined in
the PLC application from RAM into the battery backed SRAM. They are verified
and restored when the device is restarted.

• Cyclic mode
The PLC is instructed to store all retain and persistent data directly into SRAM
synchronously with every PLC cycle. This means all device types can use the
whole available memory, which is 128 kB. However, writing to the SRAM might
increase the configured PLC cycle depending on the size of used retain and
persistent data, because a SRAM is naturally slower than a RAM. This possible
increase is dependent of the application and to find out about the possible
increase one would need to monitor the configured task(s) of the project. For
projects with large amounts of persistent data, cyclic mode is recommended.

These settings must match the settings made in “Retain data options”, see
Update the CODESYS Runtime Version Using USB or SD Card or Update the
CODESYS Runtime Version Over Ethernet.

5. Make sure that Create directory for project is checked and click Next.
6. In the following window, choose the programming language for the POU created by the wizard,

and click Finish.
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5.4.2. Compile the Project
When the program is ready, a compile is needed to generate the executable code for the BoX2
device.

There are two ways to compile the project, the Generate code function which is an offline compile
and the online compile, which is triggered when logging into the device if there is a code change
from the last online session.

Compile Offline

NOTE
When a program change has been made to the project, the project must be
compiled.

The offline compile is triggered by using the option Generate code from the Build menu.

The other two options, Clean/Clean all, will remove the generated application binaries and forces
BCS Tools to regenerate the application. After a Clean or Clean all, the controller must be stopped to
be able to update the application.
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NOTE
A project can still be changed online if the offline compile is being used, if it is only
program code changes.

Compile Online

NOTE
When a program change has been made to the project, the project must be
compiled.

This compile is triggered when logging into the CPU if there is uncompiled program code. If there are
any compile errors, the login procedure will be interrupted. The compilation must be successful to be
able to login to the CPU.

If the compilation is successful, a question of online change will be shown.

5.4.3. Download the PLC Program
There are two ways to transfer the program code to your BoX2 device, the Download and the Online
Change function.

The Download function is a mode for downloading new projects and also current projects where the
PLC parameters have been changed; hardware configuration, task changes etc.

The Online Change function is a mode for downloading changes while the CPU is in RUN mode.
There is no restriction regarding how large the code change can be, as long as the only change is the
program code, the online change function is always available.

Download in STOP Mode
To download a new application or an application with hardware changes, task changes etc, the CPU
must be in STOP mode.

When logging into the CPU, BCS Tools will prompt that a download needs to be made.

When the Yes button is pressed, the CPU will enter STOP mode and the application is downloaded.

When the download is complete, BCS Tools will enter the online state with the CPU in STOP mode.
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To set the CPU into RUN state, press the RUN button in BCS Tools.

Online Change
The online change function is a mode for downloading changes while the CPU is in RUN state. There
is no restriction regarding how large the code change can be, if the only change is the program code.

When a change is made in the program code, BCS Tools will prompt with the following message to let
the user decide whether to make an online change or a download with the PLC in STOP mode.

When a login attempt is made and the program code differs between BCS Tools and the PLC, online
change is available.

When a change in parameters, tasks or other parameter related options are changed, no online
change can be performed. BCS Tools will prompt with a message asking if you want to perform a
download instead. Click Yes or No. Clicking Details... shows the code generation timestamp of the PC
vs the PLC.

Boot Application
The Boot Application is the program code that the CPU will load and execute, after powering on or
resetting the system.

When a download is made with the CPU in STOP mode, the downloaded project will be registered as
a Boot Application.

An online change updates the Boot Application per default.

5.5. Reduce Flash Wear by Storing Data on SD Cards
Beijer Electronics recommend using industrial SD card instead of the built-in flash memory when data
logging is performed. The capability to use external SD card for data logging on BoX2 devices was
introduced in iX Developer 2.40 SP5. Since extensive writing to the flash memory can cause wear
problems and possibly premature failures, the alternative to write to an exchangeable SD card will
potentially lengthen the lifetime of the device. An SD card is easy to replace compared to a built-in
memory. In addition, the memory size of the SD card is normally much larger than the built-in flash
memory.

To set up the SD card database in iX Developer:

1. Go to Project/Settings. Select Database and select SD Card in the dialog.
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2. Click on the OK Button to confirm the new settings.

When the location of the database is changed from flash to SD card (or vice versa) in an existing
application, the database will be automatically copied to the new location once the project is
transferred to the device. This will be started immediately after the project transfer has taken place
and hence a somewhat slower project start-up time can be noticed.

It is advisable to do a backup of the database in case something happens during the database copy
operation.

If during runtime of the device, the SD card is removed and the chosen location for the database is
the SD card, the panel will close the application and attempt to reboot until either an SD card is
reinserted into the device, or a project is downloaded to the device with the location set to “Hard
disk”.

Please note that if any scripting has been done towards the database, then these scripts need to be
manually adapted to work with the new location (flash or SD card).

If Audit Trail is enabled for the project and if the database is stored on SD card, the transfer client
will not provide the option to keep/remove audit trail in an existing project. It will always keep the
audit trail database. If the user wants to clear the audit trail database for the same project, the SD
card needs to be inserted into a PC and manually delete the audit trail database file.

It is also recommended to track the flash wear status in your iX Developer project.

The following System Tags can be used for that purpose:

System Tag Description

Flash Memory Life Time
Used

The usage of the device lifetime (in percent).

Flash Memory EOL Info Information about the flash memory end of life. The three
possible values are:

• Normal

• Warning - Consumed 80% of reserved block

• Urgent
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Please see document Best Practice Database on SD card or flash memory for more detailed
information.
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